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SCT
Technical Bulletin

Document Introduction
This document describes how to use the System Configuration Tool (SCT), 
including setting up archive databases offline. This document also describes the 
basic setup of an N2 and Master-Slave/Token-Passing (MS/TP) network online to 
illustrate some key differences between working online and offline. This document 
does not provide installation instructions for the SCT.

Related Documentation
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For Information On See Document LIT or Part Number
Installing a Network 
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Network Integration Engine 
(NIE)

Installing the NAE/NIE 
Technical Bulletin

LIT-1201161

Installing an NAE55/NIE55 NAE55/NIE55 Installation 
Instructions

Part No. 24-10051-0

Security Issues, Including 
Adding Users and Roles to the 
System

Security Administrator 
System Technical Bulletin

LIT-1201528

Daily Use of the Controller 
Configuration Tool (CCT)

CCT Help --

Daily Use of the SCT Metasys system Help --

Using the SCT Manager ADS, ADX, and SCT 
Upgrade Installation 
Instructions

Part No. 24-10068-6

Daily Use of the Metasys® 
System Extended Architecture

Metasys system Help --

General Network and 
Information Technology 
Definitions and Concepts

Network and IT 
Considerations for the IT 
Professional Technical 
Bulletin

LIT-1201578

Security Database Backup/
Restore

Metasys system Help --

Software Upgrade and 
Database Upgrade

ADS, ADX, and SCT 
Installation Instructions

Part No. 24-9898-1

Updating NAE/NIE Disk Images 
to New Software Releases

NAE/NIE Update Tool 
Technical Bulletin

Part No. 24-10110-18

Migrating an N1 Network into 
the Metasys System Extended 
Architecture Using an NIE

N1 Migration with the NIE 
Technical Bulletin

LIT-1201535

Integrating a BACnet® Network BACnet System Integration 
with NAE Technical Bulletin

LIT-1201531

Integrating an N1 Network N1 Migration with the NIE 
Technical Bulletin

LIT-1201535

Integrating a LONWORKS® 
Network

LONWORKS Network 
Integration with NAE 
Technical Bulletin

LIT-1201668
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SCT Overview
The SCT is a software application that assists in all phases of engineering, 
installing, and commissioning of devices that make up the Metasys system 
extended architecture. Use the SCT offline to create archive databases to download 
to a Metasys system – either to an NAE/NIE, an Application and Data Server 
(ADS), or to an Extended Application and Data Server (ADX). Also use the SCT 
to back up and restore Security Databases (that are created and edited online).

You can create and edit the Security System databases online and then use the SCT 
to back up and restore Security databases. Refer to the Security Administrator 
System Technical Bulletin (LIT-1201528) to create and edit a security database.

The SCT uses the same User Interface (UI) as the Metasys system extended 
architecture software on an NAE/NIE or ADS/ADX. The SCT can be used for 
various functions online with a Metasys system extended architecture network, 
such as scheduling downloads to NAEs.

The SCT allows commissioning of N2 Bus devices by allowing HVAC PRO 
software, GX-9100 tool software, and XTM Configurator software to access the 
Metasys system. The SCT also allows commissioning of MS/TP controllers by 
allowing you access to the CCT software. Use the CCT software to configure, 
commission, and simulate your Field Equipment Controllers (FECs), Input/Output 
Modules (IOMs), and Variable Air Volume Modular Assembly (VMA) 1600s on 
the MS/TP bus.

Upload archive databases modified in the Metasys system extended architecture to 
the SCT for archiving or editing. The SCT includes features to enable the 
synchronization of the archived and online databases. You can configure these 
features to run at specified times.
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SCT in a Metasys Network
Figure 1 shows the SCT as part of an overall Metasys system extended architecture 
network. Figure 1 shows an ADS with an SCT installed and a portable computer 
with an SCT that can be connected directly to an NAE.

NAE/NIE Configuration Flowchart
The flowchart in Figure 2 shows one of the possibilities for using the SCT to help 
configure an NAE/NIE and set up a Metasys system. In the left branch of the flow 
chart, the archive database is created and configured. This is done offline with the 
SCT and could be done prior to going to the job site. The right side shows the 
initial setup of NAE/NIEs at a site, which is done online. The security database is 
created and edited online and then backed up and restored offline using the SCT.

Figure 1: SCT as Part of a Metasys Network
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Add and configure the NAEs in the site 
with the SCT.
♦ Set up BAS Network Configurations.
♦ Configure any modems
♦ Set up SNMP (optional)

Complete building the offline archive database in 
the SCT.
♦ Add integration trunks, field devices, and 

field - points. 
♦ Add Programming Logic Using LCT. See 

the Metasys system Help.
♦ Configure alarm, audit trail, and trend 

archive. Refer to the Metasys system Help.
♦ Configure Alarm Destinations. Refer to the 

Metasys system Help.
♦ Build Graphics. Refer to the Metasys 

system Help.

Add and configure a site.

The offline archive database is complete 
and ready to download to the NAE. 

NOTE: Before downloading the archive database 
to the NAE, ensure that the settings, created in the 

NAE during the online configuration, match the 
settings in the archive database created in SCT. 
If they do not match, the SCT archive database

overwrites the settings entered in the NAE.

Install, wire and power the NAE.
Refer to the NAE35/NAE45 Installation 
Instructions (Part No. 24-10050-6) or 
NAE55/NIE55 Installation Instructions

(Part No. 24-10051-0).

1. Commission the NAE for connectivity in 
Metasys system network. See the Detailed 
Procedures section in this document to connect 
an NAE in various network scenarios and set the 
basic NAE parameters. 
2. If the NAE is not the designated Site Director, 
demote it from Site Director status. Refer to the 
Designating a Site Director section in the NAE 
Commissioning Guide (LIT-1201519). 
3. Change the NAE Computer Name value and 
assign an IP address, if necessary. (In some 
configuration scenarios, the NAE Computer 
Name may need to match the value assigned to 
the NAE archive database in SCT.)

Create and Edit Security Database Online. 
Backup and Restore Security Database in SCT.

 See the Security Administrator System Technical 
Bulletin (LIT-1201528).

If there are any ADSs or ADXs on the site, one of 
them is automatically designated as the Site 
Director. Refer to the ADS Commissioning Guide 
(LIT-1201645).
If there are only NAEs on the site, designate one 
of the NAEs as the Site Director. Refer to the 
Designating a Site Director section in the NAE 
Commissioning Guide (LIT-1201519).

Install the NAE.
Commission the NAE

online

Are there additional 
NAEs on the jobsite?

No

Ye

The NAE is ready to receive an archive 
database download from the SCT. Use the Load 

Wizard in SCT to download the database to the NAE. 
Refer to the Metasys system Help.

Configure 
an archive database 
offline in the SCT.

Figure 2: NAE/NIE Configuration Flowchart
SCT Technical Bulletin 9
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Metasys System Modes of Operation
With the Metasys system extended architecture software, you can access and 
operate specific system features in the online mode or the offline (SCT) mode:

• In the online mode, you can perform tasks such as monitoring and 
commanding a network of field devices or configuring a security database via 
an Internet browser connected to an NAE/NIE or ADS/ADX.

• In the offline mode, you can perform system configuration tasks such as 
building an archive database, configuring point objects and features, or 
backing up and restoring a security database when using a computer with the 
SCT application.

There is also a Simulation mode, in which you can simulate and test the system 
logic offline on a single NAE or NIE using the SCT application. See the 
Simulation section in this document.

Some key differences in functionality between the online and offline modes are 
shown in Table 2.
Table 2: Using Metasys System Features and Functions by Mode of 

Operation (Part 1 of 2)
Features/Functions Offline Mode

(via SCT)
Online Mode 
(via Browser to a S
Director or to an NA

Scope of Default Navigation Items in an archive 
database for single or 
multiple sites

Items in the site (includ
NAE/NIE items) can be
in the Site Director. Item
NAE/NIE can also be v
the NAE/NIE.

View User-Defined Navigation Trees X

View and Edit Items in the Navigation Tree X X

Restrict Access via Security Database Only at login X

Provide Administration Tool for Creating 
and Editing Security Database

Administers the SCT 
security database. When 
the SCT and ADS/ADX 
reside on the same 
computer, the security 
database is shared by the 
SCT and the ADS/ADX.

X

Provide Security Database Backup and 
Restore

X

Create or Delete a Site X

Create or Delete a Supervisory Device 
(NAE/NIE)

X

Create or Delete a Metasys Server
(ADS/ADX)

X

Automatically Find Field Devices and 
Field Points on a Network Connected to 
an NAE/NIE (Auto Discovery feature)

X

Create a Navigation Tree X X

Create a System, Including the Logic 
Connector Tool (LCT)

X X

Create Graphics X X
SCT Technical Bulletin10
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Metasys System Extended Architecture Software Upgrades
When you upgrade your SCT, ADS, ADX, NAE, or NIE to a new release version 
of the Metasys system extended architecture software, the database schema 
changes; therefore, you must also upgrade all archive databases from the previous 
release to new release databases.

Microsoft® Internet Explorer Browser Recommendations
Always open a new browser window to access the Metasys User Interface (UI) or 
SCT (if accessing from a Web browser). Do not use the Metasys UI browser 
window to navigate to any other Web site. If you access a Web site that requires the 
Java® Runtime Environment (JRE), configuration and runtime problems may 
arise.

If Microsoft Internet Explorer is configured to reuse windows when you launch 
shortcuts, then when you launch the following it may replace your Metasys 
application:

• launch Microsoft Internet Explorer from a shortcut on the desktop

• type a Universal Resource Locator (URL) in the address field of the task bar

Network Automation Engine (NAE)
The NAE is a Web-enabled, Ethernet-based supervisory device that monitors and 
supervises networks of field-level building automation devices. Typically the NAE 
controls Heating, Ventilating, and Air Conditioning (HVAC) equipment, lighting, 
security, and building access.

The NAE provides alarm and event management, trending, archiving, energy 
management, data exchange, scheduling, dial features, and password protection 
through the Web browser UI.

Create All Other Items Supported by an 
NAE/NIE or ADS/ADX

X X

Copy or Paste Items and Their Children Can create archive copies, 
as well as copy or paste 
items and devices.

Simulate a Single NAE/NIE X

Upload, Download, and Synchronize 
Configuration Databases

X

Commission and Create Configurations 
for N2 devices via Passthru (HVAC PRO, 
GX 9100 tool)

X

Commission and Create Configurations 
for MS/TP devices via Passthru (CCT)

X

Table 2: Using Metasys System Features and Functions by Mode of 
Operation (Part 2 of 2)

Features/Functions Offline Mode
(via SCT)

Online Mode 
(via Browser to a S
Director or to an NA
SCT Technical Bulletin 11



Network Integration Engine (NIE)
The NIE supervisory device is a specialized version of the NAE and is designed to 
provide for the migration of N1 networks into the Metasys system extended 
architecture. The NIE uses the same UI as the NAE, except that connectivity with 
LONWORKS®, BACnet, and N2 networks is not available in the NIE.

NAE/NIE Update Tool
The NAE/NIE Update Tools are a software application for updating the NAE or 
NIE flash image to the latest release of the Metasys system software. Using the 
Update Tool, you can update one or more NAEs/NIEs on the same Ethernet 
network.

NAE/NIE Point Mapping
The NAE/NIE maps device-point data to software objects in the NAE/NIE so that 
the points in the device are identified with objects in the NAE/NIE. Point mapping 
allows the NAE/NIE to read and write to the points of the device and 
view/acknowledge alarms.

On an N2 Bus, Analog Inputs (AIs), Analog Outputs (AOs), and Binary Inputs 
(BIs) are a few examples of N2 field points. The VAV Modular Assembly (VMA), 
Variable Air Volume (VAV) controller, and Air Handling Unit (AHU) are a few 
examples of N2 or MS/TP field devices.

Field points are mapped to a field device. Field devices are mapped to an 
integration object such as an N2 Trunk.

There are several ways to map points within an NAE/NIE. In the SCT, you can 
attach a resource file (with configuration information) to a field device and then 
use assisted point definition to map the points from the file. In the SCT, you can 
also manually map individual points. When you are online to an NAE/NIE, you 
can use the Auto Discovery feature to discover devices and points on a connected 
network. The new data from the Auto Discovery can then be uploaded to an 
archive database in the SCT, and the archive database can be edited offline. You 
can also manually insert points online using the Insert Point Wizard.

Note: Point discovery is not supported in N2 devices.

Application and Data Server (ADS)
The ADS is a Metasys server that consists of two components. The first 
component is the Application and Data Server software that supports the relational 
database management system, Microsoft SQL Server™ 2000 Desktop Engine 
(MSDE) software or SQL Server 2005 Express software, for storing collected 
trend data, audit trail messages, and event messages. The second component is the 
Web server software that provides user interface access to data, and routes 
commands to the Metasys system. This component may include the Site Director 
function.
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Extended Application and Data Server (ADX)
The ADX is a version of the ADS Metasys server with extended capabilities for 
historical data archiving, and it extends the multi-user Web access capabilities of 
the system. The ADX supports the relational database management system, 
Microsoft SQL Server 2000 software or Microsoft SQL Server 2005 software, for 
storing collected trend data, audit trail messages, and event messages. This 
relational database is also used to store configuration information for site security, 
trend studies, and other features.

Network Control Engine (NCE)
The Network Control Engine (NCE) Series controllers combine the network 
supervisor capabilities and IP network connectivity of an NAE wit the Input/
Output (I/O) point connectivity and direct digital control capabilities of a Metasys 
Field Equipment Controller (FEC). NCE controllers provide a cost-effective 
solution designed for integrating central plants and large built-up air handlers into 
your Metasys networks.

Archive Database
An archive database holds the configuration information for the field devices and 
field points that make up a single site or multiple sites. The archive database 
contains information about controllers, input/output points, and alarms. A single 
server can contain multiple archive databases.

Archive Database Creation
Use the SCT to create new archive databases offline. To create a new archive 
database, copy an existing archive database, or generate a new archive database. 
Then add or edit information and references to sites, controllers, communications 
trunks, and objects (such as schedules, energy management objects, and 
operators).

You can also generate a database online in a single NAE or NIE and upload the 
information to the SCT for editing and archiving. See Creating a New Archive 
Database in the Detailed Procedures section of this document.

Archive Database Backup
An archive database backup is a backup file of an archive database. You must 
restore the archive backup into an archive database before it can be used. A backup 
can be created and moved to another computer running the SCT. See Backing Up 
an Archive Database in the Detailed Procedures section of this document.

Note: Archive databases created with previous versions of the Metasys system 
software must be upgraded to the software version you are using before 
they can be opened in the SCT.
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Site
A site is a logical grouping of supervisory level devices (NAEs/NIEs) and their 
field level devices that are on the same Local Area Network (LAN). A site may 
consist of one or many supervisory devices.

Site Director
For each site, a single supervisory device or Metasys server is designated as the 
Site Director. An NAE or NIE may be designated as the Site Director on small 
networks consisting of single or multiple NAEs/NIEs. On larger networks with 
single or multiple ADSs/ADXs, an ADS/ADX is designated as the Site Director. 
The Site Director provides a uniform point of entry and supports functions such as 
user logon, user administration, time synchronization, and data-traffic 
management. Internet browsers accessing the Site Director are able to view most 
of the integrated network components.

Note: Define the Site Director by adding the appropriate ADS/ADX or NAE/NIE 
as the first device in the archive. Use the rename feature to assign the Site 
Director the appropriate name before you continue defining other devices. 
When you add or change the Site Director late in the configuration process, 
it takes a while for the database to rename all the data to reflect the change.

Site Object
The Site Object is a representation of the site, and it contains the attributes and 
values that represent the characteristics of the site. If the Site Object exists on a 
device, that device is considered a Site Director.

One important function of the Site Object is to maintain time-of-day 
synchronization for a site.

Site Organization
The SCT provides a number of ways to help organize your site. The two main 
methods are folders and User Views.

Use folders as containers to assist in organizing your archive database. The default 
NAE/NIE database contains Energy, Programming, and Schedule folders.

User Navigation Views group object references for quick access. You can add 
references to any object in the site and add folders to User Views. User Views can 
be added for each user of a site and appear when that user logs into a database.
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Security Scenarios
When the SCT is part of a site, there are four scenarios of how the Security 
Administration System integrates into the site.

Note: For more information on Security, including setting up roles and users, 
refer to the Security Administrator System Technical Bulletin (LIT-
1201528).

1. For Release 1.1 or later – On a site where the SCT is installed and an 
NAE/NIE or ADS/ADX is the Site Director and you want to:

• change Site Directors, use the Security Backup/Restore Wizard in the 
SCT to back up the Security System database of the current Site Director 
before changing Site Directors. After changing the Site Director, use the 
Security Backup/Restore wizard to restore the Security System database to 
the new Site Director. The new Site Director administers the Security 
System for the Site.

Note: Define the new or renamed Site Director first. When you add or change 
the Site Director late in the configuration process, it takes a while for 
the database to rename all the data to reflect the change.

• back up or restore a Security System database, use the Security 
Backup/Restore Wizard in the SCT to back up the Security System 
database. If the need arises, use the Security Backup/Restore Wizard to 
restore the backed up Security System database. For more information, 
refer to the Security Database Backup/Restore section of the Metasys 
system Help.

2. On a Site where the SCT is not installed on the same computer as an ADS 
that is the Site Director, the only function the Security Administration System 
plays is to add users and passwords for authentication to the SCT. Neither the 
Object-based nor System-based permissions affect the use of the SCT, even 
though all the functions are available.

3. On a site where the SCT and ADS are installed on the same computer and 
the ADS is the Site Director, the Security Administration System on either the 
SCT or ADS administers the Security System for the site.

4. On a site where the SCT and ADS are installed on the same computer and 
the ADS is not the Site Director (the ADS is only used for Data Storage), 
the Security Administration System function on the SCT only adds users and 
passwords for authentication to the SCT. The Site Director for the site is the 
Security Administrator for the ADS acting in the Data Storage Capacity.
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N2 Integration
The NAE supports all current N2 devices except the N2 Dialer, Baseframe 
products, Digital Control Module (DCM), DCM-140, and XM Configurator.

IFC-2020 and IFC-1010 are supported in a limited capacity. Addresses for 
N2 devices are in the range of 1 to 254.

Supported N2 Configuration Tools

N2 Tools are used in Passthru mode to commission N2 devices in the Metasys 
system. To perform Passthru, N2 configuration tools must reside on the computer 
with an SCT installed. Passthru applications can be launched from the SCT or 
from the online Metasy UI. In addition, Resource files, which are files created by 
N2 configuration tools, can be attached to field devices as extensions and then 
used to assist in field point generating and mapping.

See Table 3 for the file extension of the legacy tools supported by the NAE.

BACnet System Integration
The BACnet System Integration feature enables the integration of BACnet enabled 
devices (including the N30) into the Metasys system extended architecture. The 
NAE maps the BACnet system data to integrated objects you can use in Metasys 
system applications.

LONWORKS Network Integration
LONWORKS network integration enables the integration of LONWORKS enabled 
devices into the Metasys system extended architecture. The LON Integration 
object runs in an NAE.

Table 3: Supported Legacy Tools
Device/Controller 
Type

Configuration Tool File Name Expected 
During Import1

1. The files required by the N2 Integration import utility for generating Extensive 
Markup Language (XML). The original Configuration Tool files are not stored in the 
NAE.

ASC HVAC PRO, LoaderUI PRN2

2. When generating PRN files from the HVAC PRO, use the long format.

VMA HVAC PRO PRN

Vendor Vendor PRN

XP XTM Configurator, LoaderUI HMC

DX GX-9100 Tool, LoaderUI DX 
Commissioning Tool

DMO

MIG Metasys Integrator® unit VCT
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N1 Migration
The N1 Migration feature allows you to migrate an N1 Network into the Metasys 
system extended architecture using an NIE. You are able to configure and prepare 
the N1 Network, import the N1 objects either via Auto Discovery or using the N1 
Migration Tool, and migrate the N1 Network features (including Schedules, 
Calendars, and Totalization configurations).

P2000 System Integration
The P2000 system integration enables you to view objects in the P2000 security 
system from a single user interface. You can also view the objects from other 
building systems controlled by the Metasys system extended architecture. Use 
Web Services technology to integrate the P2000 system.

Wireless Integration
The Wireless Supervisor integration enables the integration of WRS-RTN 
receivers into the Metasys system extended architecture. Wireless Integration 
allows you to integrate remote WRS Series wireless room temperature sensors and 
map the sensors to N2, BACnet, LON, and Master-Slave/Token-Passing (MS/TP) 
field controllers using Global Data Sharing. The Wireless Supervisor integration 
supports up to 50 receivers and each receiver supports up to 60 wireless room 
temperature sensors.

MS/TP Integration
The MS/TP Communication bus is a local network that connects supervisory 
controllers and field controllers; Field Equipment Controllers (FECs), VMAs, 
Input/Output Modules (IOMs), and TEC BACnet Thermostats to the Metasys 
system supervisory controller. The Sensor Actuator (SA) Bus connects point 
devices (IOMs or Network Sensors) to the field controllers. For more information, 
refer to MS/TP Communications Bus Technical Bulletin (LIT-12011034).

Wizards
Wizards help you perform complicated operations and present tasks in a consistent 
format. A wizard consists of a series of steps, each correlating to a screen 
presented to the user.

A wizard may appear when you select an option from the Insert menu, or when 
you attempt to perform certain complex actions. For example, a wizard appears 
when you select Object from the Insert menu. Wizards appear the same when you 
are working online or offline.

Note: For Release 3.0, there are two types of database load wizards: the Load 
Wizard for uploading, downloading, and synchronizing archive 
(configuration) databases, and the Security Backup/Restore Wizard for 
backing up and restoring the Security System databases of Site Directors 
and other supervisory devices. Both wizards use the ActionQ to initiate and 
monitor the load or backup/restore process.
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Uploading and Downloading with the Load Wizard
Use the Load Wizard to download, upload, and synchronize databases. Access the 
Load Wizard by selecting Load Archive... from the Tools menu in the offline mode 
in the SCT. The Load Wizard collects necessary information to perform the load 
such as load type, controller names, and load time. Once you complete the wizard, 
the supervisory controller sends the load commands to the ActionQ. ActionQ 
initiates and monitors the load.

When a computer running the SCT is reset, the SCT application shuts down until 
someone logs on to the application again. If a load is scheduled and the computer 
running the SCT is reset, the load does not start until someone logs on to the SCT 
application again. Logging on to the SCT restarts the application and automatically 
starts any scheduled loads. The Load Archive options are described in the 
following sections:

Upload
The Load Wizard’s upload option transfers a copy of the NAE/NIE or ADS/ADX 
archive databases into the archive database of the SCT. Perform an upload to 
update the SCT archive database with changes made in the online mode. The 
NAE/NIE or ADS/ADX database overwrites the SCT archive database for the 
device being loaded. The direction of an upload is from the NAE/NIE or 
ADS/ADX to the SCT.

Note: To ensure recent online changes are captured during an upload, 
manually archive the NAE/NIE (Actions > Commands > Archive) and 
then upload.

Note: The NAE/NIE device automatically upgrades to Version 1.1 when you 
upload an NAE/NIE with Version 1.0 to an SCT with Version 1.1.

Download

The Load Wizard’s download option downloads (copies) the archive database from 
the SCT into NAE/NIE, ADS/ADX, and Network Control Engine (NCE) 
databases. Perform a download to send the changes made in the SCT database to 
the NAE/NIE, ADS/ADX, or NCE database. The SCT archive database overwrites 
the NAE/NIE, ADS/ADX, or NCE database. The direction of a download is from 
the SCT to the NAE/NIE, ADS/ADX, or NCE.

Synchronize
The Load Wizard’s synchronize option synchronizes an NAE/NIE or ADS/ADX 
database with the SCT archive database. When you synchronize a database, the 
NAE/NIE or ADS/ADX database is uploaded to the SCT and checked for 
consistency with the archive database. Then, only the changes in the archive 
database are downloaded back to the NAE/NIE or ADS/ADX. The changes made 
to the SCT database override changes made to the NAE/NIE or ADS/ADX 
database, and the databases match.
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Security Database Backup and Restore
Use the Security Backup/Restore Wizard to back up and restore Security System 
databases of Site Directors and other supervisory devices. An SCT archive stores 
the Security database.

In addition to the general backup/restore function, use this wizard to back up the 
Security System database before changing Site Directors. This wizard allows you 
to move the Security System from one Site Director to another.

Use the Site Director to back up/restore all devices. Using the Site Director saves 
you time because you perform fewer backups, and the size of your archive 
database is smaller because you can restore security to all devices on your site. 
Also, you can share changes made at the Site Director to all devices without 
having to log on and change settings on each device.

Auto Discovery
Auto Discovery allows an NAE/NIE to automatically find field devices and field 
points on a connected network. Auto Discovery is only available online and is not 
available through the SCT. Discovery is limited to only the integrations connected 
to a supervisory device that supports discovery.

After discovery, the new device and point information may be uploaded to an 
archive database in the SCT where you can store the new information and edit it 
offline. For an example of how to use Auto Discovery in an N2 Network 
integration, refer to the Adding N2 Field Points to an Archive Database section of 
the N2 Integration with the NAE Technical Bulletin (LIT-1201683). For an 
example on how to use Auto Discovery in an MS/TP Network integration, refer to 
the BACnet MS/TP Integration with the NAE Technical Bulletin (LIT-12011013).

Note: To perform Auto Discovery Passthru, you may access the NAE/NIE by 
logging on directly to the device or access the NAE/NIE through the Site 
Director. To access the supervisory device directly, you need the Internet 
Protocol (IP) address or host name, User Name, and Password for the 
device. To access through the Site Director, you need the Site Director IP 
address or host name, User Name, and Password.

Logic Connector Tool (LCT)
The LCT is a feature of the Metasys system software used to create a graphical 
representation of the control logic within a system. The control logic may include 
system blocks, reference blocks, and logic blocks. The Layout mode allows you to 
edit the logic offline while the View mode allows limited online commanding 
capabilities.

The LCT allows system viewing and editing via any browser logged into any 
online NAE/NIE or ADS/ADX with access to a System object. Create new logic 
systems from any browser with access to the NAE/NIE. Refer to the Metasys 
system Help for instructions on using the LCT.
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User Graphic Tool
Use the User Graphics tool to view, create, and edit graphics for Metasys systems. 
You can monitor and control a facility through a graphical interface representing 
the functionality and location of fans, controllers, and other Heating, Ventilating, 
and Air Conditioning (HVAC) equipment. Refer to the Metasys system Help for 
instructions on using the User Graphic tool. Graphics provide a visual 
representation of the monitored systems that enable you to quickly check the status 
of system symbols and recognize unusual system conditions. Graphics can be 
designed to allow you to move through buildings, floors, and other areas, viewing 
building systems and control processes. You can create new graphics from any 
browser with access to an NAE/NIE or ADS/ADX.

Backgrounds are static images displayed behind a graphic. Backgrounds are 
buildings, floor plans, mechanical equipment, and any other picture that represents 
the location or function of the equipment in the graphic. By default, a newly 
created graphic has a gray background. You can insert a background image using a 
file based on Scale Vector Graphics (SVG), Super Video Graphics Array (SVGZ), 
or Joint Photographic Engineering Group (JPEG) graphic format. You can then 
bind data to items in the graphic.

Simulation 

Note: When you are simulating for an NAE/NIE, your computer must be 
formatted for New Technology File System (NTFS). The simulated values 
for the Flash Usage and Memory Usage attributes are not accurate if your 
computer is formatted to use File Allocation Table (FAT) 32.

Simulation allows you to test the system logic created for an NAE or NIE when the 
Metasys system is offline. In Simulation, you can enter commands and see how an 
online system would react if commanded to perform the same action. The 
Simulation mode uses the same user interface and command features of the online 
system.

Simulation is run from the SCT in offline mode. You cannot run Simulation on the 
same computer as an ADS/ADX, because ADS/ADX is part of the online system. 
Simulation supports the simulation of one NAE or NIE on one site and, if you 
attempt to start a second simulation, the first simulation must be stopped.

In Simulation mode, you can perform the following tasks including:

• viewing a control system created using the Logic Connector Tool

• simulating Inputs/Outputs (I/Os)

The menu choices in Simulation are different from online or offline modes. 
Simulation does not support moving logic or items from within the simulated 
system to the archive database or online system.

IMPORTANT:  Do not run Simulation on server class machines. Stopping 
Simulation resets the Internet Information Server (IIS), and interrupts a variety 
of processes being performed by the server. 
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Simulation runs in a new browser window labeled Metasys Simulation in the title 
bar of the browser. Only the information for the simulated device appears in the 
simulation session (not the entire site). For more information on Simulation, refer 
to the Metasys system Help.

Passthru
In Passthru mode, a configuration tool (such as CCT software, HVAC PRO 
software, or GX-9100 tool software) communicates directly to a controller through 
the NAE over the LAN. In Passthru mode, the N2 device or MS/TP device appears 
offline at the NAE. Commands from the software tool go directly to the N2 device 
or MS/TP device. In Passthru, you can view both N2 trunks or MS/TP trunks of an 
NAE at the same time. The Configuration Tools show the object name as it appears 
in the NAE of the device undergoing Passthru. This object name contains the name 
of the trunk to help you determine on which trunk the device is located.

Passthru Requirements

When you connect directly to an NAE to use Passthru, the NAE must be the Site 
Director. The Passthru feature only works on direct connect to the Site Director. 
For additional Passthru information, see the Troubleshooting section.

To use the Passthru features, you must install the required applications in a specific 
order. For installation requirements, refer to the ADS, ADX, and SCT Installation 
Instructions (Part No. 24-9898-1).

HVAC PRO
HVAC PRO configures the Application Specific Controllers (ASC): VMA1400 
Series, VAV, AHU, and Unitary (UNTs) controllers.

In Passthru mode, you can use the HVAC PRO software to download, upload, and 
commission ASC devices through an NAE.

In addition, Passthru mode makes it easier to identify and manage controllers for 
common tasks by showing the user a complete list of controllers currently mapped 
in an NAE. The first step in any Passthru operation from HVAC PRO is to select a 
controller from a list. Subsequent Passthru operations, such as Controller 
Information and Upload/Download, are performed on the selected controller.

HVAC PRO restricts the number of characters allowed in each controller name. 
See HVAC PRO Name Restrictions in Passthru Mode.

GX-9100 Tool
The GX-9100 tool configures the DX-9100 and DX-9200 controllers.

In Passthru mode, you can use the GX-9100 software to download or upload the 
DX configurations. When you use the GX-9100 through an NAE, the LoaderUI 
application launches to initiate the upload or download.
SCT Technical Bulletin 21



Loader User Interface (LoaderUI) Tool
The Loader User Interface (LoaderUI) tool provides a generic method for you to 
download a previously created dxf file to a DX-9100 controller.

However, the primary use of the LoaderUI application is for the GX-9100 software 
to upload and download the DX controller. When you select Upload via an N30 
from the GX-9100, the LoaderUI launches and you use it to connect to the NAE to 
upload a file with the dxu extension. When the upload is complete, the GX-9100 
displays the information from the dxu file. You can save the file as a dxs file.

When you initiate an upload independent from the GX-9100 software, you cannot 
open the successfully uploaded dxu file by the GX-9100 software or any other 
application; therefore, you must use the GX-9100 software to initiate the upload of 
a DX controller through the NAE.

Note: The LoaderUI only supports uploading one device at a time. XT/XTM 
uploads over the N2 bus and XT/XTM only uploads are not supported by 
the LoaderUI. You can upload an XT/XTM with a DX upload, if it is 
connected to the XT bus of the DX controller.
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XTM Configurator
The XTM Configurator supports building configuration files for XTMs.

Note: The XTM Configurator tool does not support N2 passthru but can be used 
to download XTMs using a serial connection.

N2 Device Loader
Opens the N2 LoaderUI window. You can browse to the location of the DX-9100 
device file and other N2 device files to upload and download. All devices found on 
the selected NAE/NIE appear with the Address, Device Type, and Object Name. 
You can open the device file in the GX-9100 or HVAC PRO tool.

DX Commissioning

Opens the DX Commissioning Tool.

Controller Configuration Tool (CCT)

The Controller Configuration Tool (CCT) is used to configure, simulate, and 
commission the Field Equipment Controllers (FECs), Input/Output Modules 
(IOMs), and VAV Modular Assembly (VMA) 1600s, on a MS/TP bus. CCT 
operates in three modes of operation that provide key functionality for your 
system: Configuration, Simulation, and Commissioning.

Metasys System Help
The Metasys system Help is the User’s Guide for the Metasys system extended 
architecture. The Help provides information on procedures such as downloading, 
global searching, commanding, and scheduling and also contains information on 
objects, the user interface, and wizards. The Contents, Index, and Search tabs in 
the left pane of the Help allow you to find information by browsing through 
defined sections, looking up key terms, or by performing a full-text search of the 
Help content. The Favorites tab allows you to bookmark sections that you access 
often. You can print the information appearing in the scrollable region in the right 
pane of the Help, but to print larger sections of the Help or the entire Help system, 
go to the PDF file of the Metasys system Help on QuickLIT.

The Metasys system Help is available in all modes of operation via the Help menu 
or by pressing F1. When you press F1 to launch the Help, the Microsoft Internet 
Explorer Help system also appears. Close the Internet Explorer Help system. 
When you access the Metasys system Help from a device to which you have 
browsed, a File Download dialog box appears asking if you want to open the Help 
file or save it to your computer. Click Open to access the Help or Save to choose a 
location on your computer where you want to save the Help file. To access this 
saved Help file, browse to and double-click on 
MetasysSystemExtendedArchitecture.chm. You can access this Help without 
accessing a Metasys device, but MetasysSystemExtendedArchitecture.chm is 
approximately 3 MB; therefore, be sure you have space available before saving the 
Help file to your computer.
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SCT Manager
The SCT Manager allows you to have multiple versions of the SCT on your 
computer. The SCT Manager creates a snapshot of the databases from the earlier 
versions of the SCT. For more information on the SCT Manager, refer to the ADS, 
ADX, and SCT Upgrade Installation Instructions (Part No. 24-10068-6).

Detailed Procedures

Starting the SCT
The SCT install should also place a Metasys SCT icon on your Microsoft 
Windows® operating system desktop. Double-clicking this icon also starts the 
SCT.

From the Computer Where the SCT Is Installed

To start the SCT from the computer where the SCT is installed:

1. On the Windows operating system Start Menu, select Programs > 
Johnson Controls > Metasys > Metasys SCT. The Welcome to Metasys screen 
appears.

2. Click the Close Window button on the Welcome screen. A dialog box lets you 
know that the application is trying to close the window. Click Yes to allow it to 
do so.

3. When the Metasys Login screen appears, type your user name and password, 
and click the Login button.

4. If archive databases have been created, the Open Archive dialog appears.

5. Select the desired database and click OK. The SCT screen appears.

If an archive database has not been created, the Create New Archive wizard starts. 
See Adding a Metasys Server (ADS/ADX) to an Archive Database in this 
document.

From a Computer without the SCT Installed
To start the SCT from a computer without the SCT installed:

1. Start your Web browser.

2. Type the URL of the SCT in your browser and press Enter. In Microsoft 
Internet Explorer, the URL field is called address. The Welcome to Metasys 
screen appears.

You can add the Metasys SCT URL to your browser Favorites list.

3. Click the Close Window button on the Welcome screen. A dialog box lets you 
know that the application is trying to close the window. Click Yes to close the 
window.
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4. When the Metasys Login screen appears, type your user name and password, 
and click the Login button. If archive databases have been created, the Open 
Archive dialog box appears.

5. Select the desired database and click OK.

If an archive database has not been created, the Create New Archive wizard starts. 
See Creating a New Archive Database in this document.

Creating a New Archive Database
To create a new archive database:

1. On the Item menu, click New Archive. The New Archive Wizard screen 
appears.

2. Type a name for the new archive. Note the following restrictions:

• Archive names are not case sensitive. All archive files are created in the 
same directory.

• Archive names cannot be longer than 120 characters.

• The first character can only be an alphabetical character from a to z.

• No special characters can be in the name. For example, ! @ # $ % . and & 
are not allowed.

• Archive names cannot include spaces.

• Archive names cannot be a Structured Query Language (SQL) reserved 
word. For example, you cannot create an archive and name it create, 
database, or select. There are a number of SQL reserved words, and an 
error message appears if you attempt to use one.

• HVAC PRO controllers have name restrictions. See HVAC PRO Name 
Restrictions in Passthru Mode.

3. Click the Create button. A new archive is created. You are prompted if you 
want to add a site to the new archive. See Adding Sites to an Archive Database 
in this document for more information.

You cannot create a new archive database if another archive database is already 
open. You are prompted to close any open archive database before creating a new 
archive database.

Go to Adding Sites to an Archive Database.

Opening an Archive Database
To open an archive database:

1. On the Item menu, click Open Archive. The Open Archive Wizard appears.

2. Select an archive from the list and click the Open button. If an archive database 
is already open, you are prompted to close it before the selected archive 
database opens.
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An archive database may be used by only one user at a time. An open archive 
database locks out additional users. The open archive database appears on the 
Open Archive list with a locked lock icon next to it, and the User Name of the open 
archive database user is displayed.

Go to the Populating an Archive Database section in this document.

Copying an Archive Database
The Archive copy must have a unique name. By default, the new archive has the 
same name as the one you are copying with a number appended to the name.

To copy an archive database:

1. With an archive database open, click Create Archive Copy on the Item menu. 
The Copy Archive Wizard appears.

2. Select the Archive to copy from the list.

3. Click the Copy button.

4. Click Yes when prompted to close the current database. The new Archive copy 
opens.

Deleting an Archive Database
Only one archive can be deleted at a time. An open archive can be deleted.

To delete an archive database:

1. On the Item menu, click Delete Archive. The Delete Archive Wizard opens.

2. Select the archive to be deleted and click the Delete button.

3. Confirm the deletion.

Populating an Archive Database
The following procedures can assist you in configuring an archive database for a 
Metasys system extended architecture system. They are listed in the order in which 
they should be performed when creating a new archive database. For example, to 
add a supervisory device to a database archive, you must first have a site defined in 
the archive. In addition to the following procedures, you can speed up your work 
by starting with copies of archive databases, by importing previously exported 
portions of databases, and by copying and pasting items within an archive 
database. Importing and exporting portions of databases is described later in this 
document.

These instructions are written from the point of view of building an archive 
database for an N2 network. Perform the same procedure for an MS/TP network 
but select the appropriate MS/TP trunk. See Figure 3 for an example.

To populate an archive database:

1. Add sites to an archive database. In the example (Figure 3), the archive 
database is MyArchive2 and the sites are Site1 and Site2.
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2. Add Metasys servers to an archive database if applicable. In the example 
(Figure 3), the Metasys server is an ADS labeled ADS1.

The Object Category drop-down menu shown in the right panel allows you to 
select a category for the object. Permission to view or act on different object 
categories is assigned to users and/or roles.

3. Add supervisory devices to an archive database. The example shows 
supervisory devices NAE1 and NIE1. An NIE is required to add an N1 
Integration object to an archive database.

4. Select an N2 trunk from the (default) NAE archive database. The archive 
database in Figure 3 shows two N2 trunks (N2 Trunk 1 and N2 Trunk 2) added 
to NAE1.

5. Add N2 Field Devices to an archive database. Visible field devices in Figure 3 
are AHU-1 and TC-2.

6. Add N2 Field Points to an archive database. See ZN-T under the Analog inputs 
folder of TC-2 in Figure 3 for an example of an added N2 field point.

Adding Sites to an Archive Database
You must have at least one archive database defined. See Creating a New Archive 
Database in this document for details.

Figure 3: SCT with Archive Database
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To add sites to an archive database:

1. With the Archive Database open, click Site on the Insert Menu. The Insert Site 
Wizard’s Destination screen opens (Figure 4).

2. Select an archive database and click Next.

Note: You must already have created at least one archive database to 
populate.

3. Follow the prompts on the screen to configure each site in the archive. See 
Table 4 for details.

4. Click the Finish Button. A site is created with the parameters you have 
selected, and you are prompted to create a supervisory device or a Metasys 
Server in the new site.

Go to Adding a Metasys Server (ADS/ADX) to an Archive Database section or 
Adding Supervisory Devices (NAEs/NIEs) to an Archive Database section in this 
document.

Table 4: Insert Site Wizard Screens
Screen Purpose
Destination Type or select the archive database to which you are adding the site.

Identifier Type a unique name for the site.

Configure Set the editable attributes of the Site object you are configuring, including Connection
Site Time Servers. See the Site object Help for further information. Clicking the Adva
button on this screen allows you to access the BACnet system features of the Site ob

Summary View the basic parameters of the site just added.

Figure 4: Insert Site Wizard - Destination Screen
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Adding a Metasys Server (ADS/ADX) to an Archive Database
When there is an ADS or ADX on a site, it is automatically the Site Director. If 
there are multiple ADSs or ADXs added to a site, the first ADS or ADX added is 
the Site Director by default.

To add an ADS or ADX to an archive database:

1. With the Archive Database open, click Metasys Server on the Insert menu. The 
Insert Metasys Server Wizard starts (Figure 5).

2. Follow the prompts on the screen to configure the Metasys Server. See Table 5 
for details.

3. Click the Finish button.

Table 5: Insert Metasys Server Wizard
Screen Purpose
Object Type Select the type of Metasys Server you are adding. For example, ADS Version 1.0.

Destination Select the site where the Metasys Server resides.

Identifier Type a unique name for the Metasys Server. A unique name is required for each Me
Server in an archive. By default, the name of the object has a number appended to 
unique. Therefore, if adding an ADS to a site for the first time, the default name is A

Configure Access features of the Metasys Server, including:
• Email – Set up Simple Mail Transfer Protocol (SMTP) and Post Office Protocol (

destinations. Add email addresses for the Metasys Server to send messages.
• Pager – Enter phone number information for sending messages to a pager.
• SNMP – Enable Simple Network Management Protocol (SNMP) and add destina

Summary View the basic parameters of the Metasys Server just added.

Figure 5: Insert Metasys Server Wizard - Select Object Type Screen
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Adding Supervisory Devices (NAEs/NIEs) to an Archive Database
To add Supervisory Devices to an archive database:

1. With the archive database open, click Supervisory Device on the Insert menu. 
The Insert Device Wizard Select Object Type screen appears (Figure 6).

Figure 6:  Insert Device Wizard - Select Object Type Screen
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2. Follow the prompts on the screen to configure the Supervisory Device. See 
Table 6 for details.

3. Click the Finish button.

Exporting Part of an Archive Database to a File
To export part of an archive database to a file:

1. Open an Archive.

2. On the Item menu, click Export Item. The Export Archive Wizard starts 
(Figure 7).

Table 6: Insert Device Wizard Screens
Screen Purpose
Object Type Select the type of Supervisory Device you are adding.

Destination Select the Site where the Supervisory Device resides.

Identifier Type a unique name for the supervisory device. A unique name is required for each 
supervisory device in an archive. By default, the name of the object being entered ha
number appended to keep it unique; therefore, if adding an NAE to a site for the first
default name is NAE1.

Configure Access NAE/NIE features, including (See Metasys system Help for the NAE Device 
a description of the attributes on these screens: including default values and ranges.
• Configuration – If Basic is selected, you can edit parameters such as name and 

description. If you select Advanced, you can configure additional parameters suc
Engineering values, Alarm snooze, Audit Trail, and Site information.

• Communications – Configure the serial port, internal, and external modems.
• Network – Enter the LAN settings and configure dial-up settings for accessing the

over dial-up connections.
• Email – Set up SMTP and POP destinations. Allows you to add e-mail addresses

NAE/NIE to send messages.
• Pager – Enter phone number information for sending messages to a pager.
• SNMP – Enable SNMP and add destinations.

Summary View the basic parameters of the Supervisory device just added.
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The source must be at a level lower than a Site object. You cannot export an entire 
site as an item.

3. Select the item to export and click Next. The Export Archive Wizard Identifier 
screen appears (Figure 8).

4. Enter a unique name for your export file. This is the name that appears in the 
Import Archive Wizard’s Select File screen (Figure 10).

5. Click Next. The Export Archive Wizard Summary screen appears (Figure 9).

Figure 7: Export Archive Wizard - Source Screen

Figure 8: Export Archive Wizard - Identifier Screen
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This screen displays the information that appears when the user presses the 
info button on the Import Archive Wizard’s Select File screen.

6. If the Summary appears correct, click Finish. Otherwise, click Back and edit as 
necessary.

Importing Part of an Archive Database from a File
To import part of an archive database from a file:

1. Open an archive database.

2. On the Item menu, click Import Item. The Import Wizard appears (Figure 10).

Figure 9: Export Archive Wizard - Summary Screen

Figure 10: Import Wizard
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3. Select the file you want to import and click the Import button. If an item of the 
same name already exists, a dialog checks to verify that you want to overwrite 
the existing item.

Importing a file discards all change status indicators (the little green arrows in 
the navigation tree) from your database. Importing a site director device into a 
database with existing User Views is not supported and may cause loss of User 
View data.

When the import is complete, the new item appears in your navigation tree.

Backing Up an Archive Database
Backups are saved as.zip files and stored in the default directory:
C:\Documents and Settings\All Users\ApplicationData\Johnson Controls\MetasysIII\DatabaseFiles

To back up an archive database:

1. Open an archive database.

2. On the Tools menu, select Database > Create Backup. A message appears 
telling you that the backup was successful.

Restoring an Archive Database
To restore the database backup file it must be in the following directory: 
C:\Documents and Settings\All Users\ApplicationData\Johnson Controls\MetasysIII\DatabaseFiles

To restore an archive database:

1. On the Tools menu, select Database; then click Restore Backup. The Restore 
Archive Wizard appears.

You can restore a backup of an archive database file only when it is not in use. 
Archive database files that are in use are locked and unavailable.

2. Click Restore. If the archive currently exists, the Confirm Delete and Restore 
message appears (Figure 11).

3. Click Yes to Delete the current archive with the name selected in Step 1 and 
replace it with the most recent backup of that archive.

4. Open the restored archive if desired. The version now available in the Open 
Archive Wizard is the last version that was backed up.

Note: Do not rename the backup file.

Figure 11: Confirm Delete and Restore Message
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Inserting a User View
To insert a user view:

1. Open an archive database.

2. On the Insert menu, click User View. The Create New User View Wizard 
starts.

3. Follow the prompts on the screen to configure the User View. See Table 7 for 
details.

4. Click Finish when you are done.

Launching N2 Configuration Tools and CCT in Passthru Mode
N2 Devices are configured using N2 configuration tools in Passthru mode in the 
SCT. To use the N2 configuration tools in Passthru mode, install the 
N2 configuration tools on the machine where you are using them.

CCT devices are configured using CCT in Passthru mode in the SCT. To use CCT 
in Passthru mode, install CCT on the machine where you are using them.

To launch N2 configuration tools and CCT in Passthru mode:

1. Open the archive database in the SCT or log on to the NAE.

2. On the Tools menu, select Field Device Tools, then click the N2 configuration 
tool you want to use or CCT (MS/TP). The selected tools opens in Passthru 
mode.

If you are launching a Passthru session from the SCT, you are guided through a 
logon sequence to log on to the Site Director that contains the devices that 
contain the N2 controllers or MS/TP controllers.

Any offline conditions/actions in the Site Director (such as a download to the 
Site Director) interrupts N2 and MS/TP Passthru communications.

Note: When you use the GX-9100 tool in Passthru mode, NAEs appear as 
N30 devices in the UI of the GX-9100 tool.

Table 7: Insert User View Wizard
Screen Purpose
Destination Select the site and user view folder for the new user view.

Identifier Type a unique name for the User View. A unique name is required for each User View
By default, the name of the object being entered has a number appended to keep it u
therefore, if adding a User View to a site for the first time, the default name is User V

Configure Click on the Tree View tab to add and remove references to the objects that you wan
appear in your new User View. Organize your view by adding folders to group your re
according to your preferences. Note that the root of the tree view or the folder in whic
want to add a reference must be selected for the Add Reference button to work.

Summary View the basic parameters of the User View just added.
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HVAC PRO Name Restrictions in Passthru Mode
HVAC PRO Release 8.06 and later restricts the number of characters allowed in 
each controller name. HVAC PRO does not download, upload, commission, or 
retrieve information about the controller if the item name or controller name 
exceeds the 157 maximum characters limit.

The controller’s full name consists of the: domain name, site name, equipment 
name, trunk name, and the actual controller’s name. The controller name appears 
in the following format:
Site_name:device_name.domain_name/N2 Trunk #.controller_name

Table 8 describes the controller name restrictions.

HVAC PRO Naming Recommendations

Use the following list of naming conventions to assist you while naming your 
controllers. If the recommendations are followed, there are an additional 61 
characters available.

• site name under 15 characters

• device name (network name) under 15 characters

• the default N2 Trunk name unchanged so it only consists of 10 characters (for 
example N2 Trunk 1 or N2 Trunk 2)

• controller’s name under 15 characters

Table 8: Controller Name Restrictions1

1. The component column lists each of the components represented in a Full Item reference. The Max
Viewable Characters column lists the restrictions on the Component names when entered through
or a Web-based user interface of the Metasys supervisory controller. The Maximum Characters Al
by HVAC PRO column shows the maximum number of characters in a Full Item Reference allowe
HVAC PRO.

Component Maximum 
Number of 
Characters 
Allowed by the 
NAE or SCT

Maximum 
Viewable 
Characters

Maximum 
Characters 
Allowed by 
HVAC PRO

Site Name fewer than or equal to 32 30 47 157

Device Name fewer than or equal to 15

Domain Name fewer than or equal to 64

N2 Trunk Name fewer than or equal to 32 -

Controller Name fewer than or equal to 32
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Troubleshooting   
Table 9: Troubleshooting
Error/Error Message Description
When you attempt to execute any N2 
Passthru tool (for example HVAC 
PRO) from the ADS, ADX, or NAE 
user Interface, the error appears: 
“The Supervisory Controller 
does not contain any supported 
devices”

Date and/or time may be incorrect. Verify that all dates and
correct.
For more information, refer to Appendix A: Time Zone, Dat
Management in the ADS Commissioning Guide (LIT-12016

Item name may be too long. See the HVAC PRO Name Re
Passthru Mode.

SCT does not log on to allow HVAC 
PRO to load despite already being 
logged on to the NAE.
SCT (offline) allows you to log on and 
run HVAC PRO, but you receive a 
ZSWHPRO crash when you try to do 
anything over Passthru.

The Site Director is offline. Log on and verify it is online.

Logon responds with “Unable to 
Login. Unexpected Error.”

SCT must be completely uninstalled. You may also have to
5.0 and the .Net Framework. Reinstalling SCT should fix th
If there are error messages from the Installer, there may als
at runtime.

Verify the JRE proxy settings are disabled. To verify proxy 
disabled:
1. From the Start menu select > Settings > Control Panel.
2. Select the Java icon. The Java Control Panel appears.
3. Select the Proxies Tab.
4. Uncheck Use browser settings.
5. Click OK.

SCT installer responds with 
“XPPKInitConsole,exe crash”

Error typically occurs if IIS 5.0 is installed after the .Net Fra
Uninstall .Net, IIS, and SCT. Reinstall in the following orde
SCT.

HVAC PRO gives the item reference 
of the NAE but fails to get any 
controllers and causes 
ZSWHPRO.EXE to crash.

Only the second N2 Trunk is integrated. Integrate the first 
even if it has no controllers on it. You must integrate the fir
N2 Trunk 2 is being used in HVAC PRO even if there are n
the first N2 trunk.

Downloading and uploading the 
database of an NAE in SCT causes a 
Communication Error (521).

The SCT is case sensitive for the names of the NAE devic
new Supervisory device in SCT and give it the exact same
NAE. For example, the name ‘nae’ is different from ‘NAE’ i

N2 applications may respond with no 
information or lock up.

Two N2 Passthru Applications may not run at the same tim
in Passthru mode. Close all of the N2 Passthru application
Run one N2 Passthru application at a time.

Downloading/Uploading the database 
of an NAE in SCT causes a 
Communication Error (521) or error 
(522).

This error occurs when the NAE/NIE have domain names 
them, but they are not defined in SCT. When you define a 
new Supervisory device in SCT, you must include the dom
part of the name (for example, NAE.cg.jci.com instead of ju
also possible to use the IP address of the device that the ar
taken from.

SCT upgrade tool fails with the 
archive upgrade log error for a 
restored database:
 “In ConvertArchives: Error in 
reading archive data for 
fixbuild1, Empty Archive”

Verify the name of the backup matches the name of the arc
the backup and archive names match: log onto the Site Di
name at the top of the tree is the archive name. Rename th
backup database to match the archive name, restore it, an
archive upgrade again.

When you attempt to use one of the 
N2 Passthru tools, the following error 
message appears 
“Supervisory Device Offline”

M-Tools may have been installed while running the N2 Pas
Shutdown all active N2 Tools and SCT. Reinstall SCT. 
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Technical Specifications  

A DX9100 device may remain offline 
after exiting the GX9100 
Commissioning tool. This occurs 
when the tool is run in passthru 
mode from an ADS. In the NAE, the 
DX9100 N2 Device tab shows:
Offline = True and Enabled = True

The GX9100 device is disabled at the GX9100. To enable 
device, You must first command the DX9100 N2 Device to
command the DX9100 device to Enable.

The N2DeviceLoader/LoaderUI 
(LoaderUIG3.exe) crashes when you 
try to connect to the site.

The error typically occurs when you have a child NAE liste
Site Director. When the child NAE appears offline (with a r
the N2DeviceLoader/LoaderUI crashes.
Right-click on the offline NAE and choose Remove from S

The SCT installed without error, but 
the SCT UI window freezes or stalls 
while Java is loading.

A wireless connection manager may be installed on the ma
present, uninstall the wireless connection manager. As a re
to Microsoft Knowledge Base Article KB910435.

System Configuration Tool
Product Code MS-SCTSWO-0

Recommended 
Computer Platform1

1. Our suggested minimum hardware configurations are only suggestions and are not meant to imply that 
machines are not usable. For more information about hardware configurations and their implications, re
Hardware Requirement section of the Network and Information Technology (IT) Considerations Technic
1201578).

2.8 GHz Pentium® 4 processor with 80 GB hard disk (2.0 GHz Pentium 4 proc
40 GB hard disk minimum)
20 GB recommended free hard disk space available (600 MB minimum)
CD-ROM drive

Memory 1 GB RAM recommended (512 MB RAM minimum)

Operating System (OS) Microsoft Windows 2000 Professional with Service Pack (SP) 4
Microsoft Windows 2000 Server or Windows 2000 Advanced Server with SP4
Microsoft Windows Server 2003 (Standard or Enterprise) with SP12, 3

Web Server Software: Microsoft Internet Information Server (IIS) Version 5.0 o
Microsoft Windows XP Professional with SP15 or SP2
Web Server Software: Microsoft Internet Information Server (IIS) Version 5.1 o

2. Windows Server 2003 OS R2 has been released; however, at this time, we support only Windows Serve
SP1. If you are currently running Windows Server 2003 OS with SP1, you do not need to upgrade at th
have not yet purchased Windows Server 2003 OS, you may purchase Windows Server 2003 OS R2 th
regular channels. The Windows Server 2003 R2 installation includes Windows Server 2003 OS SP1 an
components. Install only Windows Server 2003 OS SP1. Do not install any of the optional R2 compon

3. Refer to the Network and Information Technology Considerations (IT) Technical Bulletin (LIT-1201578)
settings required to make this operating system work with an Extended Application and Data Server (A

4. For the split ADX configuration, install the ADX software and Internet Information Server (IIS) on the W
server computer only.

5. If your Windows XP Professional computer includes SP2, refer to the Network and Information Techno
Considerations Technical Bulletin (LIT-1201578) for special settings required to make this operating sy
an SCT.

Web Browser Microsoft Internet Explorer Version 6.x or Version 7.0 or later
Java Runtime Environment 1.5.0_10

Communication Ethernet network interface card 10/100 Mbps (100 Mbps network recommende

Optional Software 
Packaging

Metasys System Configuration Tool (SCT) software is included with the ADS/A

Table 9: Troubleshooting
Error/Error Message Description
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